Colour Management for Digital Photographers

by

Rob Griffith

www.nativedigital.co.uk

Contents

The theory bit ............................................................ 2
Getting your monitor right ........................................ 3
Photoshop settings .................................................... 4
Photoshop Elements settings .................................. 5
Operating System settings ...................................... 5
Getting better scans ............................................... 6
Shooting accurate colour ....................................... 6
Ink on paper ........................................................... 7

© The Colour Collective Ltd. 2004
The theory bit

Film photographers have been managing colour for years. They choose a film stock that they like and get to know what it is capable of. In the darkroom they take care over exposure, developing times and temperatures and they know that if they change their photographic paper they will get different results and so compensate accordingly. Yet the same photographer who converts to digital often expects to achieve great results without taking any such care. They will change software settings, papers or inks and be surprised that what they see on their monitor does not match what comes out of their printer.

Why don’t colours match?

Think about what is involved in taking a digital image and then printing it on an inkjet. Firstly each digital camera will capture colours slightly differently. Then when you import that image into your image editing software it will interpret the RGB values based on some kind of internal setting and then display them on your monitor. The software can’t know what kind of monitor you have, it doesn’t know if you have turned the brightness all the way up or down, whether you are using a CRT or LCD monitor. Then you decide to print to an inkjet, a device that doesn’t even work in RGB but uses CMYK inks. You may be using the manufacturer’s own inks and papers or you may have changed them. How will your image editing software know this? Each and every colour device that you use will have a different range of colours that it can reproduce - they will have different colour gamuts.

A good analogy would be that each device speaks a different language and in order to get your colour meaning across accurately from one device to another you need a translator. This is where colour management comes in.

So, what is a profile?

Colour management works, very simply, by measuring how each device reproduces colours. These measurements are stored in special files called ICC Profiles. To continue the language analogy, a profile is the colour dictionary for a device. If you want to translate colours from one device to another, for example from a scanner to a printer, you start by looking up a colour in the scanner’s profile, its colour dictionary, and then try to find the closest match for the same colour meaning in the printer profile. Obviously you don’t do this manually (the application that you are using does it all automatically) but you have to have the right profiles for your devices and you have to tell your software to use them.

Step by step

There are a number of steps that you’ll need to go through to get your system colour managed. The first is to be able to trust that what you see on screen is a true representation of your image. In order to do this you have to calibrate and profile your monitor. Monitor profiling equipment has come down in price over the last few years. Systems start at about £80 and go up to £250. Like anything else you get what you pay for. The cheaper systems will have less options and maybe slightly less accurate. All the software is pretty easy to use.

The next step will be to make sure that your image editing software is set up to use the right profiles. You’ll also need to look at how you are capturing your images so camera settings might need to be adjusted. One thing many photographers are finding is that shooting RAW instead of JPEG images can improve their colour accuracy. You can also colour manage your scanner and your inkjet printer to get a full end-to-end colour managed system.

Don’t expect miracles

Even the most highly colour managed systems always display some differences in colour between devices. Colour management can get the best out of a device but it can’t increase the range of colours a device is capable of. If you are using cheap inkjet paper you will still get better results with a higher quality media, even if you have a profile. Also one big factor when comparing print to screen is the light you are looking at the print under. If you look at the same print under daylight and a tungsten light bulb, then the print will look more yellow under the artificial light. Fluorescent lights are very poor for viewing prints - daylight or specialist lighting is best.

Colour management is a very complex subject and this has only scratched the surface. If you are serious about learning more then the best book on the subject is Real World Color Management by Bruce Fraser, Chris Murphy and Fred Bunting available on our website – www.nativedigital.co.uk.
Getting your monitor right

**Lighting & Environment**

Images look best on a computer monitor when it is the brightest light source that you can see. So the first thing that you should do is to turn down the lights and close the blinds. You should see the contrast and saturation of your images on screen instantly improve. Monitor hoods can also help.

It is also important that you have no bright colours around your monitor. If the wall behind your screen is bright orange then this will affect how you see your images. Grey is the best colour to use if you have to be critical about colour. Your lighting is also crucial. Every light source (light bulbs, fluorescent tubes, or computer monitors) have a colour bias or colour temperature to them. If your budget can’t stretch to some of the specialist controlled lighting on the market then daylight is the best light to view colour images under.

Calibrating your monitor

The software and hardware to measure your monitor’s output is relatively inexpensive and very easy to use. All you have to do is to load the software, attach the measuring instrument to your computer and follow some easy on screen instructions. You may be asked to adjust some settings on your monitor so you’ll need to know how to adjust brightness, contrast and colour temperature.

The first thing that the software will do is to calibrate your monitor. This means that your monitor will be adjusted to match certain standards. These are usually defined in terms of the white point, or colour temperature, of your monitor and also the gamma or tonal curve. Some systems now also let you choose a luminance or brightness level as well. Generally the best colour temperature to calibrate your monitor to is 6500°K. This is because it closely matches indirect daylight.

Profiling your monitor

Once the monitor calibration is complete the software will then continue to create an ICC Profile for that monitor. An ICC profile is a file that describes how your monitor, scanner or printer reproduces colour. An accurate profile enables applications like Adobe Photoshop to know exactly how your monitor displays colour and it will adjust the way the image is displayed to make sure that you are always shown an accurate representation of your image.

You will be asked to name and save your profile at the end of the process. Make sure that you store the profile in the location that the software suggests as this is probably where the profile needs to be stored to be accessed by your applications. The software should also set the new profile to be the display profile of your monitor automatically so you don’t need to set it in your operating system.

Monitor calibration and profiling tools are relatively inexpensive.

Monitor calibration and profiling tools like Monaco Optix XR will ask you to choose white point and gamma. 6500°K and 2.2 are usually the best choices.

Gamma is important because difference in brightness or contrast between monitors is very obvious and by choosing a standard gamma value. 2.2 is usually best as you will get better shadow contrast and have a better chance of matching what you see on screen to your input and output.

The monitor calibration software will display colours on screen and then the colorimeter will measure the output. Then the calibration software will adjust the appearance of the monitor accordingly until the desired colour temperature and gamma is reached.

Colour Management for Digital Photographers
Users who want a full explanation of the Colour Management options in Photoshop CS should download our Photoshop Colour Settings PDF. Here we will just cover the most important elements for photographers.

Colour Settings
The Colour Settings dialogue defines the default behaviour of Photoshop’s colour management features. Correct settings here can enhance your workflow. Incorrect settings can cause you serious problems. You can access this dialogue through the Photoshop menu on Mac OS X or the Edit menu on Windows/Mac OS 9.

The Settings menu loads a series of presets that set all the options for you. Most users will be happy with these suggestions. The default, out-of-the-box, preset for Photoshop versions 6 and 7 is called Web Graphics Defaults. As the name implies these settings are optimised for working on internet content, and also because Adobe is a US company the CMYK working space is a US printing standard - SWOP. The default, out-of-the-box, preset for Photoshop CS (version 8) is called North America General Purpose Defaults and this uses the same profiles as Web Graphics Defaults. For European graphics professionals Adobe recommend the preset called Europe Prepress Defaults. This setting will usually result in some improvement in both conversion and soft-proofing for most European users. For home users Europe General Purpose Defaults may be OK.

Working Spaces
Web Graphics Defaults colour settings load sRGB as the RGB working space. sRGB’s advantage is that it is widely supported by equipment and software manufacturers. For example, many digital cameras produce images in the sRGB colour space and many printer drivers assume that you are sending them data in sRGB. So for many home users sRGB is a good choice. However sRGB is quite a small colour space so if your professional digital camera, scanner or high-end Inkjet has a larger colour space then you will always be limiting the range of colours that you can achieve if you use sRGB.

A larger RGB colour space that is part of the Europe Prepress Defaults is Adobe RGB (1998). This colour space is a good one because it is larger than a lot of device colour spaces so that you aren’t limiting the colours you can achieve but it isn’t so large that you are working with colours that can never be printed. Its one disadvantage is that if you assign it to an image that has been created in sRGB then some colours can look over saturated. In this case you either use sRGB for the image or assign sRGB and then convert to Adobe RGB (1998).

Profile Warning Dialogues
When the Ask When Opening options are checked in Colour Settings Photoshop will warn you when you are opening a file that either has no profile embedded or is tagged with a different profile to your defined working space. These warnings may seem intrusive and annoying but if you use them properly they can give you better results from supplied and legacy images.

If you get the Missing Profile warning then it is best to Assign Working RGB. If the image does not look correct then you can go to Edit, Assign Profiles, and choose a different profile. If you get the Profile Mistmatch warning then the best thing to do may be to Use Embedded. This way you will see the image as the last person who opened it did. One thing you should not do is to Convert the image as this changes the image and it may not be for the better.

Europe Prepress Defaults are a good choice for many users.
Photoshop Elements Settings

By default Photoshop Elements uses very simplistic colour management. However if you choose Color Settings from the Edit menu you can turn on more advanced colour management options.

If you set the Color Settings to Limited Color Management then Elements will display your images based on a profile called sRGB. sRGB is a widely used colour space and may well suit many cameras. However if you set the Color Settings to Full Color Management then Elements uses Adobe RGB (1998). Adobe RGB (1998) is a larger colour space than sRGB and is even supported by some cameras. If you are unsure which setting to use then take a test shot, open it in Elements and try switching the Color Settings and see how your image looks on screen, providing you have calibrated your monitor. Choose the setting that looks best. Don't think that you should always choose Adobe RGB because it is a bigger colour space; images from your camera may look better with sRGB because the manufacturer may have optimised their hardware to work with this very common colour space and also your printer may work best with sRGB files.

Operating System Settings

Both the Windows and Macintosh computer operating systems have colour management settings and options, however there are only two things that you really need to know for each system – where to store profiles and how to set the display profile.

Windows 2000 and XP
All ICC profiles on Windows must have the file suffix “.icc” or “.icm”. The easiest way to install an ICC profile onto a Windows computer is to right click on the file icon of the profile and select Install Profile from the menu. This will automatically copy the profile into the correct location. The file icon should now be white and the profile will have been copied to:
C:\Windows\NT\System32\Spool\Drivers\Color.

To check that your monitor profiling software has set the display profile correctly you’ll need to access your Display Properties by right clicking anywhere on the desktop. Then click on Advanced and then the Colour Management tab. You can load a profile or set one as the default for that display.

Macintosh OS X
There are three locations for storing profiles under OS X but only one is recommended:
Macintosh HD/Library/ColorSync/Profiles
Profiles stored in this location will be accessible to all users of the computer.

To check your display profile launch System Preferences from the Apple Menu and then click on Displays. Then click on Color and the profiles available will be displayed and the profile set for that display will be highlighted.

Selecting the right profile for your monitor is vital, but your monitor profiling software should do it for you automatically.
Getting better scans

The first step to colour managing a scanner is to check what settings are currently being used. Five minutes spent with the manual or online help can often save you a lot of grief later. The most important thing is to make sure that the RGB output profile of your scanner software is the same as your RGB Working Space in Photoshop.

To create an ICC profile for a scanner you have to give it an eye test. You have to scan a special target and then put that image into a profiling software package. The profiling software then compares the RGB values in the image to a measurement file supplied by the target manufacturer. This file contains information on the exact colours in each of the patches on the target and enables the profiling software to know how your scanner sees colour. The profiling software then creates an ICC profile for the device that can be used in your scanner software or applications such as Photoshop to get much better colour results. Typically you will get an image that virtually matches the original photograph you scanned. You will have to do little or no retouching.

Shooting accurate colour

There are three approaches to colour managing digital photography. Each has its own strengths and weaknesses and each will suit a different type of user.

Camera Settings
Many of the more expensive digital compacts and most digital SLRs have different matrix settings that conform to common colour spaces like sRGB and Adobe RGB(1998). If the camera is set to Adobe RGB(1998) and that is the RGB Working Space that you have chosen then you should get a better match between what you saw through the viewfinder and what you see on screen. However, the results won’t always be as accurate as the next two methods, but it does mean you can shoot much as you were before.

RAW
Many digital photographers are now shooting in the RAW format rather than JPEG. RAW is often called the digital negative because it captures all the data from the camera chip. When you shoot JPEG data it is heavily processed and compressed. Shooting RAW gives you the chance to alter the white balance, exposure, color casts and even chromatic aberration, and all this can be done to raw data from the chip before any information is lost in compression or processing. The only downside is that RAW files are larger than JPEGs but as media is now much cheaper than it used to be and comes in higher capacities it isn’t much of a problem.

Camera Profiling
For the ultimate in colour accuracy you can create a custom ICC profile for your camera and lighting set up. This does produce very accurate results and the process is very similar to profiling a scanner, you just use a MacBeth Colorchecker chart instead of an IT8. Camera profiling is great for fine art or product photography were absolute accuracy is needed, but it is difficult to apply outside the studio and does lengthen the time it takes to set up a shot and process it on your computer.
Ink on paper

Getting a custom ICC profile for your inkjet printer can really improve your prints and is vital if you want to get a print that matches your screen. A printer profile will also help you get results from third-party ink or paper suppliers that are as good as, if not better than, your printer manufactures’ own ink and media.

Printer Profiling

To profile a printer you have to output a series of colour patches and then measure those colours with a spectrophotometer, a highly accurate colour-measuring device. The profiling software then compares the measurements to the RGB values that were output and builds the profile.

Unfortunately spectrophotometers are expensive and only worth buying if you think you’ll be doing a lot of printer profiling. Another popular choice is software like Monaco EZColor that uses your scanner to measure the colours. This can work well if you have a good quality scanner and is much cheaper than buying specialist hardware.

Cheaper still is a remote profiling service, such as ours. You just download a file to print, then post it to us and we use our spectrophotometer to measure the colour and then send you the profile via email. You’ll have to follow some instructions and turn off any colour correction in the printer driver but you don’t have to buy any software or hardware and you have the confidence that experts are doing the hard work for you.

Using a printer profile

To print from Photoshop or Elements select Print with Preview from the File menu. Select your new profile under the colour management option’s Print Space. The default settings should work well but you may wish to try selecting Perceptual instead of Relative Colorimetric if you get unsatisfactory results. Don’t forget to use the same custom settings in the printer driver as you did for outputting the colour patches. Remember that the profile will only improve your printed results if you use exactly the same paper, ink and printer driver options.

Further Information

No article on such a complex subject as colour management can hope to answer all your questions and this has only been a brief overview covering the most important elements for photographers. For further information try the websites and books listed below, or just email support@nativedigital.co.uk and we’ll happily answer any questions that you have.

Books - all available from our website
Getting Colour Right
Understanding Color Management
Real World Color Management

Websites
www.nativedigital.co.uk
www.colourcollective.co.uk
www.apple.com/colorsync
www.adobe.com - search for “color management”
www.hutchcolor.com

Devices like X-Rite’s Pulse can provide an easy and inexpensive way to create your own ICC profiles for printers of all types.